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Version 4.01.08.04 – January 2026 

A. Software Description 

KellyDown is a well-planning and survey monitoring application designed specifically for use by 

well-planners and/or directional drilling coordinators at the rig-site or in the drilling office. It 

comprises an advanced multi-well relational database, sophisticated well-planning and survey 

data entry interfaces with smart data import and export modules, intuitive correction run and 

project-ahead modules, a comprehensive anti-collision module and full reporting capability. Its 

main advantage over similar products is its comprehensive list of features coupled with its user-

friendly interface. 

In the well-planning office, it is used to import or create multi-structure projects, configure multi-

well slot templates, design simple and complex well plans, define casing programs, survey tool 

programs etc. and test for collision avoidance. 

During the drilling stage, it is used by the directional drilling coordinator to achieve the optimum 

well path to one or more targets while also testing for proximity against adjacent wells in the 

drilling project and produce customised and professional looking reports right at the rig site.  

KellyDown has been tested on Windows
®
 XP (SP3), Windows

®
 Vista, Windows

®
 7, Windows

®
 8, 

Windows
®
 10 and Windows

®
 11. 

B. System Requirements 

To use KellyDown, you need: 

 The Microsoft
®
 Windows

®
 XP (SP3) through Windows

®
 11 operating system. 

  An Intel or Intel-compatible processor. 

 At least 8 GBytes of installed memory (16 GBytes recommended). 

 At least 500 MBytes of free disk space. 

C. Installing KellyDown 

Click here to go to the KellyDown website. 

Download the KellyDown Setup file from the KellyDown website to your computer. To do this, 

simply click on the two red Download Setup.zip button. By default the files will be 

downloaded to your Downloads folder. After the download has completed, click on the Open 

Folder button to go to the Downloads folder. 

http://www.kellydown.ca/download
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Open the KellyDown_Setup_3.07.10.00.zip file (or whichever version was downloaded), right 

click on the Setup.exe file and select Copy from the popup menu. Return to the Downloads 

folder, right click anywhere in the folder and select Paste from the popup menu to copy 

Setup.exe to the Downloads folder. 

Next double click on Setup.exe file to launch the KellyDown Setup routine. If Windows asks if 

you want to allow the program to continue and/or to make changes to your hard drive, click Yes 

or Run this program anyway. If Windows tells you that Windows protected your PC, 

click on the More Info link and then click on the Run anyway button. 
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Follow the instructions shown in the KellyDown Setup. When asked to select an Install Type, 

decide whether you want to install the Example Database or not.  

If this is the first time that KellyDown has been installed on your computer, you should select the 

Complete option, which will install KellyDown and the KellyDown Example Database onto 

your computer. 

If KellyDown was already installed on your computer, select the default Upgrade option. This 

will install the new version of KellyDown without overwriting you existing KellyDown database. 
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KellyDown Setup will ask where you want to install the software. It is recommended that you 

install the software in the default location. 

 

Next, KellyDown Setup will ask where the shortcut icons are to be installed. If you prefer to 

install the shortcut icons into a different location, select it from the drop-down list. KellyDown 

Setup will install icons for the software, the User Manual, the QuickStart Guide and for the 

Uninstall routine. A shortcut for the software will also be installed on your desktop. Delete it 

afterwards if you do not want it on your desktop. 
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When KellyDown Setup has enough information to install the software, you will be prompted for 

final confirmation before the software is installed. Click on the Next button to proceed with the 

installation. 

 

Wait while KellyDown Setup installs the software onto your computer. 
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After the software has been installed, a message will tell you how to start the KellyDown 

application. Click on the Finish button to close KellyDown Setup. 

 

Tip: if you already have KellyDown installed on your computer, you just need to open the Help, 

Check for updates menu in KellyDown and after confirming; KellyDown will download and 

install the latest version automatically. 

If you have any problems installing KellyDown, please contact KellyDown Support at the 

following email address: 

support@kellydown.ca 

mailto:support@kellydown.ca
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D. Starting KellyDown 

To start KellyDown, double click on the KellyDown shortcut icon on your desktop or 

select All Programs, Agilis Applications, KellyDown from the Windows
®
 Start 

menu. 

When KellyDown loads for the first time, a message will inform you that you do not have a valid 

KellyDown license installed on your computer. KellyDown will continue to operate in limited 

evaluation mode even though you do not have a valid license. 

Limited evaluation mode allows you to perform all of the functions in the licensed version except 

save proposal data and/or survey data to the database. 

  

To unlock the software or to apply for a Fully Functioning Evaluation License, send an email to 

KellyDown Support at support@kellydown.ca (or to your local or company designated 

KellyDown support person), quoting the information displayed on the message. If an email 

application (like Microsoft Outlook) is installed on your computer, click on the Yes button to 

launch the email application with the Agilis email address and license information filled in for 

you. Complete the rest of the information shown in the email message... 

mailto:support@kellydown.ca
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If you have a web-based email account (like Hotmail or Gmail or a web-based company email 

account) answer No to the question and use the Ctrl-V key combination to paste the license 

information into the body of a new email message. 

Send the email to support@kellydown.ca or to your company’s designated KellyDown support 

person and Agilis Software Solutions (or your company’s KellyDown support person) will send 

you a license within two (2) business days. You may continue to use KellyDown in evaluation 

mode until you receive the KellyDown license. When you receive the license, copy it to the folder 

shown in the email message. If you need to be reminded of the folder location, simply run 

KellyDown again to display the message. 

KellyDown will then prompt you for a password for the Admin account in the Example 

Database. 

mailto:support@kellydown.ca
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Enter a password of at least six characters. Try to use a password that contains upper and lower 

case characters, numbers and special characters, e.g. & or $. An indicator next to the password 

shows you how strong your password is. Red indicates a weak password and green indicates a 

strong password. 

Confirm the password and then enter a hint to remind you of the password in case you forget it at 

a later date. Use a password and hint combination that only you understand. Click on the 

Continue button to start using KellyDown. 

Important: If you are installing KellyDown on a computer running Windows 7 or later on which 

a previous version of KellyDown was installed, you may need to Reset the KellyDown 

Virtual System files. Virtual System Files are part of the Windows security system and prevent 

older files from being overwritten. However, this may prevent some important KellyDown system 

files from being updated to the new version. To allow these to be updated, we have added a 

function to KellyDown that deletes the old versions of the files; simply open the 

Administration, Utilities menu and click on Reset KellyDown Virtual System Files.  

 

Click on the Yes button to delete the files.  

When you run KellyDown for the first time with a valid license, depending on your company and 

regional location, KellyDown will be configured with the appropriate company branding and 

preferred options. If however, you wish to change these options, simply open Administration, 

System Settings and adjust the options to suit your requirements. Please refer to the User 

Manual and Getting Started Guide for more detailed instructions. 
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If you have any comments about using KellyDown, if you discover any bugs, or if you would like 

to suggest improvements or enhancements, please contact KellyDown Support at the following 

email address: 

support@kellydown.ca  

E. History 

Version 1.00.00.00 – released on 1st March 2012 

Version 2.00.00.00 – released on 24th May 2013 

Version 3.00.00.00 – released on 19th June 2015 

Version 3.01.00.00 – released on 25th March 2016 

Version 3.02.00.00 – released on 8th July 2016 

Version 3.03.00.00 – released on 14th October 2016 

Version 3.04.00.00 – released on 2nd December 2016  

Version 3.05.00.00 – released on 17th March 2017 

Version 3.06.00.00 – released on 18th August 2017 

Version 3.07.00.00 – released on 1st June 2018 

Version 4.00.00.00 – released on 24th August 2020 

Version 4.01.00.00 – released on 24th August 2021 

Version 4.01.01.00 – released on 15th November 2021 

Version 4.01.02.00 – released on 4th February 2022 

Version 4.01.03.00 – released on 23rd February 2023 

Version 4.01.03.07 – released on 15th September 2023 

Version 4.01.04.00 – released on 1st October 2023 

Updated KellyDown Website 

Updated links to new download site that enables Check for updates and Download Help functions etc. 

Users need to download and install the patch (or full setup) from http://www.kellydown.ca/download if 

the currently installed version of KellyDown is earlier than 4.01.04.00 

 

 Switched to updated website. 

 Added option under the View menu to show or hide inactive profiles in the Database Explorer. You may also use the 

F6 key to show or hide inactive profiles. 

 Added new function to Survey Editor and Slidesheet Editor to create a new concatenated survey from surface. 

Version 4.01.04.01 – released on 7th October 2023 

 Updated links to new download site that enable Check for updates and Download Help functions etc. Users need to 

download and install the patch (or full setup) if the currently installed version of KellyDown is earlier then 

4.01.04.00 . 

mailto:support@kellydown.ca
http://www.kellydown.ca/download
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Version 4.01.04.02 – released on 13th October 2023 

 Fixed bug introduced in version 4.01.04.01 that prevented KellyDown from launching if there was no internet 

connection. 

 Fixed bug in Survey Import routine where data wasn’t converted properly when importing data from a file where the 

depths were in metres when the depths in KellyDown were set to a different unit. 

 

 Modified export and report modules whereby company specific formats are now exposed to all users, thereby 

allowing contract directional drillers who have their own KellyDown licenses to output data in formats that were 

previously only available to companies who had specifically requested those formats. 

 Modified Compass import routine whereby importing a single profile into KellyDown will cause KellyDown to 

search for the corresponding tie-on depth in all of the existing profiles under the same well and ask the user if he or 

she wishes to tie the new data onto that parent, thereby simplifying the task of updating a new wellplan when one is 

sent to the rig from the well-planning department.  

Version 4.01.04.03 – released on 7th November 2023 

 Fixed bug in daily drilling export function where wrong records were exported when drilling run contained only 

records with no increase in bit depth. 

 Fixed bug in daily drilling export function where run number wasn’t updated when the run number increased during 

the period covered by the daily report. 

Version 4.01.04.04 – released on 21st December 2023 

 Fixed bug in proximity scan module where the size of the uncertainty ellipsoid wasn’t calculated correctly for 

ISCWSA Rev.5 MWD+IFR1error models under certain conditions. 

 Fixed bug in Quick-Scan module where distance and direction to adjacent well wasn’t calculated correctly when 

Last Survey Range was selected. 

 

 Modified Pipe Tally module whereby the user may now paste a collection of records consisting of a description 

followed by a pipe length in the spreadsheet from which KellyDown will calculate the survey station depths etc. 

from the BHA back up to surface.  

 Modified Proximity Scan module whereby forward projections are interpolated at the same user defined scan 

interval as the survey data for detailed proximity reports. 

 Added new option to Proximity Scan Options dialog named Bit Projection, which by default scans from the last 

survey depth to the bit depth. If the scan is called from the main KellyDown screen or from the Survey Editor, a 

straight line projection from the last survey to the bit is assumed. If the scan is called from the slidesheet, the motor 

output over the slide-ahead distance and then a straight line projection to the bit is assumed. If the scan is called 

when a Forward Projection module is open, information is copied from the forward projection. The user may modify 

the End Measured Depth if preferred. 

Version 4.01.05.00 – released on 8th January 2024 

 Added function under the Administration, Utilities menu to move the complete KellyDown Documents folder to a 

different location. This may be used to move the default KellyDown Documents folder out of the Windows 

Documents folder if the Windows Documents folder is located under the OneDrive folder, which could potentially 

cause problems for very large projects. It is recommended that the KellyDown Documents be moved to the root of 

the C: drive, i.e. C:\KellyDown Documents. 

 Modified KellyDown Installer whereby it checks the location of the KellyDown Documents folder and updates new 

files to the same location.  

 Added a routine when KellyDown starts, to check the existence of the KellyDown Documents folder and if one is 

not found, KellyDown will prompt the user to locate the folder manually. 

 Moved menus for importing from a Compass transfer file from the Administration, Utilities menu to the File menu. 

 Added option under the main KellyDown View menu to Show or Hide inactive profiles in the Database Explorer. 

Pressing the F6 key has the same function.  

Version 4.01.05.01 – released on 26th January 2024 

 Added several new ISCWSA Rev.5 IPM Error Models to installed database. 

 Added new Proximity Report Type named “Email Summary” to list of Proximity Scans whereby the current well is 

projected from the last survey to the bit depth using the motor output and slide ahead values from the Slidesheet 
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Editor and then straight extrapolated to one, two and three times the dogleg reference distance. This projection is 

then scanned for proximity against all selected wells in the Database Explorer and the results are automatically 

emailed to all Alert Recipients selected under Job Properties, Alerts
12

. 

 Modified Instrument Performance Import module whereby the user may now select which error models he or she 

wishes to import from a .kdemf file. Use this function to distribute company approved IPM files to rig personnel. 

 Added ability in System Settings whereby holding down the Ctrl key whilst clicking on the “Import error models 

from a transfer file” button will download the latest copy of the Instrument Performance Models from the 

KellyDown download site and present the user with a list from which he or she may select IPMs to import into the 

current System database. Selecting files will either import new files or update those that already exist under the same 

name. 

 Added new Scan Range option to Proximity Scan Options dialog named Bit Projection, which allows the user to 

perform a proximity scan along the projection to the bit. 

Version 4.01.05.02 – released on 9th February 2024 

 Added new Activity to Slidesheet Editor called Bit Projection, which calculates projection to the bit based on the Bit 

Distance, Motor Output, Slide Ahead Distance and Toolface Orientation, and adds a temporary survey to the 

slidesheet from which you may determine the offsets to the plan, dipping planes, hardlines etc. You may also edit 

the depth, inclination and azimuth of the bit projection to see further ahead of the bit if desired
12

. 

 Added function to Visualiser whereby holding down the Shift key and clicking on a Dipping Plane (after having first 

initialised a dimension line by holding down the Ctrl + Shift keys) will show the distance from the initial point to the 

point on the dipping plane that is vertically above or below the initial point. 

 Added function to Dipping Plane Editor which toggles between two possible calculation types. The first is typically 

used in conventional drilling where a dipping plane is referenced to a vertical depth (or sub-sea depth) below the 

well origin and the dipping angle is entered by the user. The second is typically used for river crossings to define 

ground level where the user enters vertical depths at each of several distances from the well origin and the dip angle 

is calculated by the software. Toggle between the two methods by clicking on the Toggle Calculation Method button 

on the toolbar. 

 Added function whereby KellyDown checks for and displays messages from Agilis Software Solutions when 

KellyDown starts, thereby allowing important messages to be delivered directly to KellyDown users. Each new 

message is displayed only once. The last read message may be viewed again by selecting the View, Start-up 

Message menu. 

Version 4.01.05.03 – released on 23rd February 2024 

 Fixed bug in Magnetic Calculation model where Description for HDGM models showed Magnetic Model was 

HDGM 2010 even for later dated models. 

 

 Changed the way in which KellyDown reacts when clicking on an editable dropdown list in worksheets whereby it 

now selects the text in the cell. 

 Added new Customer Option to show the Activity Chart as a Pie Chart instead of a Bar Chart in Drilling Reports
12

. 

 Added ability to append more than one Bit Projection activity to the bottom of a slidesheet. Also added function 

where pressing the Esc key will delete any appended Bit Projections from a slidesheet
12

.  

Version 4.01.05.04 – released on 10th April 2024 

 Fixed bug in Slidesheet module where the Adjust Slidesheet Depths routine didn’t work. 

 Fixed bug in KellyDown Visualiser where clicking on a solid lease line to measure the distance from a profile 

caused an error message. 

 Fixed bug in KellyDown Visualiser where clicking on a profile on other than the current structure did not accurately 

position the cursor when the North Reference was True North. 

 Fixed bug in Dipping Planes Editor where the Driller’s Dip Direction wasn’t enabled when the option was set to 

define the start and end dip depths. 

 

 Improved the logic by which the major axes are drawn and labeled in the QuickScan module. 

 Added function in Visualiser where holding down the Ctrl + Alt keys when clicking on a profile will cause the 

dimension line to be initialised at the last survey record for the profile section. 

 Added function to Slidesheet Editor whereby a backup of the slidesheet is saved at regular intervals during editing 

so that it may be recovered if KellyDown detects that the slidesheet data was not saved at the end of the last editing 

session due to a system crash or power outage. 
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Version 4.01.05.05 – released on 8th May 2024 

 Fixed bug in Compass import module where user was warned about orphan profiles from previously imported 

Compass profiles. 

 Fixed bug in Proposal Editor where a radius of curvature value was not correctly converted to a dogleg rate when the 

dogleg units were set to other than metric. 

 

 Updated Help and User Manual. 

 Added function to Visualiser module where pressing the B keyboard key will toggle between a light and dark 

background. 

 Modified Proposal Editor whereby each row in the spreadsheet is identified by a colour that matches colours in the 

KellyDown Visualiser making it easy to identify the corresponding proposal sections in the Visualiser. The colours 

in the Visualiser revert to the default or user-defined colour when the proposal editor is closed. 

 Added Sort button to Columns Editor which sorts and un-sorts the available fields alphabetically. 

 Added UTM Zone 55 on Geodetic Datum of Australia 2020 (GDA2020). 

Version 4.01.06.00 – released on 23rd August 2024 

 Fixed bug in Components Catalogue editor where importing a catalogue from a KellyDown transfer file didn’t work 

properly. 

 Fixed bug in Survey Export to a Winserve .say file where the Northing and Easting coordinates were exported 

incorrectly. 

 Fixed bug which caused file not found errors to be displayed when importing from a Compass Transfer File if a 

magnetic model did not exist in KellyDown or was named differently in KellyDown. 

 

 Added menu option in Component Catalogue to purge unused component classes. 

 Added ability to export and import components between the Components Catalogue Editor and Microsoft Excel. 

 Added option under Tools, Options, Proximity Options to find the closest well for only the bottom five survey 

stations when the Survey Editor or Slidesheet Editor opens, thereby speeding up loading of the survey editor and 

slidesheet editor if closest well columns are present.  

 Added option to show North/South of Plan and East/West of Plan columns in Survey Editor, Slidesheet Editor, 

custom reports and custom export formats.  

 Added function to Slidesheet Editor under the Tools menu, to paste an unlimited number of interpolated HiFi Nav 

corrected surveys into an existing slidesheet. The surveys are inserted into the Slidesheet as Deviation Surveys
13

. 

 Modified Drilling Reports module whereby Deviation Survey activities whose duration is zero hours are not shown 

in Activity and Drill Records sections of reports. 

Version 4.01.06.01 – released on 12th September 2024 

 Added functions to the Components Catalogue Editor whereby you may now import and export components to and 

from component catalogues files.  

 Added functions to the Components Catalogue Editor whereby you may now import and export the complete 

component catalogue to and from component files. 

 Added ability to update all surveys and slidesheets from surface to the bottom of the current slidesheet with 

corrected interpolated HiFi Nav™ surveys
13

. 

Version 4.01.07.00 – released on 1st November 2024 

Updated KellyDown Licensing Mechanism 

Versions of KellyDown prior to 4.01.07.00 will not work with KellyDown licenses 

issued after 31st December 2024. 

Use the Help, Check for updates menu in KellyDown to download and install version 4.01.07.00. 

 If Help, Check for updates doesn’t work, manually download and install the latest patch from 

http://www.kellydown.ca/download. 

 

 Fixed bug in Quick Scan module where measured depths weren’t shown correctly when the module first opened.  

 Fixed bug in Dipping Planes Editor where values copied to the clipboard were copied in metres even when the units 

were set to feet.  

http://www.kellydown.ca/download
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 Updated Proximity Reports whereby the first column that contains the structure, well and profile name is now 

wrapped if the text does not fit inside the column.  

 Updated the licensing mechanism whereby the KellyDown license may now be shared by all Windows User 

Accounts on a computer on which KellyDown has been installed
13

. 

 Updated Quick Scan module whereby measured depths and pseudo clearance factors are now shown in tooltips on 

full scan plots. Also added a line representing the pseudo clearance factor limit to ladder plots and excluded 

overlapping lines on child and parent profiles. 

 Added option to copy polygon target points to the Windows clipboard, from which they may be pasted into 

Microsoft Excel or into the Hard Line Editor. 

 Added option under the Project menu to recreate the Structure, Well and Profile IDs from their respective Names
13

. 

Version 4.01.07.01 – released on 20th December 2024 

 Improved QuickScan module by minimising effect of jumbled highside azimuths in full scans where inclinations are 

less that 6°. 

 Added option in Slidesheet Editor to delete all HiFi Nav™ records in the current slidesheet and optionally in all 

parents including slidesheets and surveys
13

. 

 Added option under Project menus to recreate Profile IDs from Profile Names using different methods (after 

importing from a Compass transfer file).  

 Added IGRF 2025 Magnetic Model to KellyDown setup. 

Version 4.01.07.02 – released on 14th January 2025 

 Fixed bug in Remote Monitoring Simulator that prevented it from working with recent modifications to the 

slidesheet. 

 

 Added optional label to top left of Visualiser showing the current well name and current profile name. 

 Added handle to Visualiser that allows user to hide or show the selection panel to the left of the Visualiser. 

Version 4.01.07.03 – released on 3rd February 2025 

 Fixed bug in Oasis export file where Survey Depth was sometimes mislabelled as Measured Depth. 

 Fixed bug in custom export routine where KellyDown saved a value in scientific notation if it was close to zero but 

not zero. 

 Fixed bug where new WMM Magnetic Model 2025 wouldn’t calculate. 

 

 Added function to ROC Edition of KellyDown whereby pressing the F4 key will alphabetically arrange all instances 

of KellyDown on the computer monitor depending on how many instances are currently active. 

 Added status indicator bar to bottom of ROC Edition screen that turns red to indicate when new data arriving in the 

ROC Edition is outside predefined tolerances, i.e. distance to closest well, distance from plan, hard lines or lease 

lines etc. 

 Added option to Client Configuration that sounds a ping when new data arrives from the remote server. A more 

intrusive sound is emitted if new data breaches predefined tolerances. 

Version 4.01.07.04 – released on 14th March 2025 

 Minor bug fixes. 

 

 Added function to Edit Tie-on dialogue where, if the profile is an orphan, clicking on the button at the bottom right 

will search for the most probable parent survey and tie-on depth. 

 Improved custom export module whereby comments, casing sections, survey tools and formation tops are now 

included in the Comments column at interpolated depths if the custom format includes only survey type columns 

and a Comments column and the option to include embedded comments has been checked on the Export Option 

dialog. 

 Added function to KellyDown start-up where, if no recent databases exist in the Recent File list (i.e. after 

KellyDown is first installed), KellyDown will check if any KellyDown databases already exist under the Public 

Documents/KellyDown Documents folder, and if so, will add them to the top of the Recent Databases list. 

 Modified Slidesheet whereby appending a Bit Projection activity will assume inclination and azimuth values based 

on the slide seen and toolface orientation values. 
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 Added option to select the Reporting Time for custom export files and custom reports if a Daily Export/Report is 

selected in Export/Report Options. 

Version 4.01.07.05 – released on 18th April 2025 

 Fixed bug in Slidesheet Editor where the bottom survey of each run wasn’t updated when applying HiFi Nav 

corrected survey data. 

 Fixed bug in remote monitoring module where warning message stated that the credentials between the current well 

and the remote well did not match even when they did (update function worked properly though). 

 Fixed bug in Proposal module where error was thrown when user entered a value directly into the spreadsheet that 

wasn’t on the row immediately below the last row calculated. 

 

 Added option under Tools, Options, Display Options to automatically resize column widths to fit their contents 

when each spreadsheet opens
14

. 

 Added function to Target Editor whereby pressing the = key while editing a Target ID will insert the current Well 

ID in front of the Target ID if it doesn’t already contain the Well ID. 

 Added function to the main KellyDown screen, the survey editor and the slidesheet editor whereby holding down the 

Ctrl key when clicking on the Targets button or the Edit Targets menu will open the current target directly instead of 

the list of targets attached to the current well. 

 Added ability to create a target from a Formation Top or Dipping Plane. 

 Added a new textbox to the Target Editor, which shows the vertical section distance to the target plane along the 

target plane axis. Use this to move the target forward and backwards along the target plane axis. Enter either the 

actual target section distance or a value preceded by a + or – sign to adjust the current target section distance
14

.  

 Added a new function to the Target Editor whereby the target thickness may be adjusted using a positive or negative 

value, by preceding the value with a + or – sign. 

 Added Intermediate, Tangent and Nudge sections to list of Hole Sections in the slidesheet module. 

 Modified the Ouija Board interface whereby changing the dogleg rate will automatically centre the projection at the 

target centre if the “Automatically centre new survey data” box is checked. 

 Updated Visualiser whereby lease lines are now updated dynamically as they are edited in the Lease Line Editor. 

Version 4.01.07.06 – released on 13th June 2025 

 Added function whereby pressing the F5 key or selecting the View, Refresh worksheet menu will automatically 

resize all columns in a worksheet to the width of their respective contents
14

. 

 Added option to assign an offset well to a proposal and added columns to the proposal editor that the show 

proximity etc. to the offset well. 

 Added ability to select a proposal as offset an well (previously you could only select a survey). 

 Added optional columns to the proposal editor that show the distance above and below formation tops and dipping 

planes
14

. 

 Added optional columns to the proposal editor that show the name, distance and pseudo clearance factor of the 

closest well
14

. 

 Added option to freeze a column in the proposal editor
14

. 

 Added Auto-Recovery function to Slidesheet Editor whereby the slidesheet is saved to an auto-recovery file after 

ever survey entry. If KellyDown crashes or the computer shuts down unexpectedly for any reason, when the 

slidesheet is reopened, KellyDown will check the recovery file and ask the user if he or she wishes to recover any 

data in the recovery file that may have been lost
14

.  

 Added option to show uncertainty ellipses at every 6 metres or 20 feet (instead of 30 metres or 100 feet) in the 

Visualiser by holding down the Ctrl key whilst also checking the Uncertainty Ellipses checkbox
14

. 

 Modified function of F4 key where it will now bring all KellyDown instances to front as well as organising them 

alphabetically. Also added function whereby subsequent ROC instances are always displayed on top when first 

opened
9
. 

 Modified Export module whereby Bit Projection activities are not included in Oasis export files. 

 Updated Help and User Manual. 

 Modified logic behind Administration, Utilities, Copy Preferred Magnetic Model to all Profiles in the Current 

Project menu whereby the routine will now only copy the Preferred Magnetic Model to all Profiles whose current 

Magnetic Model is set to “User Defined”, unless the user holds down the Ctrl key when clicking on the menu, in 

which case it will copy the Preferred Magnetic Model to all profiles in the current project. 

 Added button to Print Option dialog whereby the user may open the Profile Properties to change the Report 

Comments. 
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 Added sub-menu to Administration menu where the Administrator may purge all files in the KellyDown backup 

folder that are more than 365 days old
14

. 

Version 4.01.07.07 – released on 11th July 2025 

 Fixed bug in Export module where embedded comments weren’t always included in the exported data. 

  

 Added option in Tools, Plot Options to incorporate the Structure Surface Errors into Uncertainty Ellipses in the 

KellyDown Visualiser. Checking this box will add the surface error of each structure being scanned and the structure 

error of the reference well and to each offset uncertainty ellipsoid if the well isn’t on the same structure as the 

reference well, thereby enabling the accurate display of ellipsoid separation where Structure Surface Errors have 

been defined
14

.  

 Added ability to show uncertainty errors as conic ellipsoids instead of as a series of individual ellipses in Visualiser. 

Set the option whether to show regular ellipses or conic ellipsoids under Tools, Options, Plot Options. You may also 

switch between the two options by holding down Ctrl key when checking the Uncertainty checkbox in the 

Visualiser. Conic Ellipses are only shown if there are fifty or less survey sections selected to help prevent out-of-

memory errors
14

. 

 Added option in Tools, Option, Plot Options to set the opacity of conic uncertainty ellipses in the Visualiser
14

. 

 Modified the Drillstring Editors whereby you may now select individual components from a dropdown list, or 

include the Select column in the list of columns that will allow you to select components from a detailed list of 

components already stored in the database. You may also manually enter each component individually under the 

Description column and then use the Update Catalogue menu to add any components to the Components Catalogue 

that don’t already exist. 

 Added check when importing an IPM file that the file contains valid #ShortName, #Description and #ToolGroup 

information before allowing it to be imported into KellyDown. 

Version 4.01.08.00 – released on 22nd August 2025 

 Fixed bug in Survey editor module and Slidesheet module where formation tops weren’t shown unless they were 

penetrated by the current profile. 

 

 Updated to latest version of Agilis Remote Access Utility (TeamViewer 15.68.5) allowing clients’ own version of 

TeamViewer to be used for KellyDown support. 

 Added option in Custom Export routine to save an Excel file to either an .XLS file or an .XLSX file. Select the 

appropriate format from the Export dialog box
14

. 

 Added ability to update multiple surveys and slidesheets from surface to the bottom of the current slidesheet with 

corrected interpolated HiFi Nav™ or roundLAB™ surveys
13

. 

 Added ability to automatically update all surveys in the survey editor or slidesheet editor with corrected survey data 

from a roundLAB watch file. Simply configure the roundLAB (.csv) file as a watch file and KellyDown will update 

the current slidesheet survey data whenever the file is updated with corrected surveys
14

. 

 Added ability to update a Magnetic Model file with a newer version (specifically for the WMM magnetic model 

where the file name doesn’t change from one version to another). Hold the Ctrl key down and click on the Edit 

magnetic model button to import a different file for an existing model. 

Version 4.01.08.01 – released on 12th September 2025 

 Fixed bug introduced in version 4.01.08.00 where the dipping planes weren’t shown in custom reports and custom 

export formats even when those columns were selected. 

 

 Added options in the Tie-on dialog when KellyDown searches for which profile a proposal should be tied on to, to 

associate the discovered survey with the proposal and deactivate all other proposals under the same well. 

Version 4.01.08.02 – released on 24th October 2025 

 Fixed bug in slidesheet editor where updating parent surveys and slidesheets with corrected HiFi Nav data caused 

corrections to be applied to parent profiles below the tie-on depth of the corrected child profile where the parent 

profile had been sidetracked by the child profile
13

.  

 Fixed bug in Drillstring Editor where components weren’t saved to the database if a Component Type wasn’t 

selected by the user. 

 Fixed bug in Export to an .XLSX file where the routine didn’t always write the file. 
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 Added option to include Depth vs. Inclination and Depth vs. Azimuth charts in Survey and Proposal Reports
14

. 

 Added popup menu to the Well that will alternate the colours of all surveys and proposals below the current well. 

 Added option in the Drillstring Editor to change the Component Type for an existing component by holding down 

the Ctrl key when selecting a Component Type from the dropdown list. 

Version 4.01.08.03 – released on 9th December 2025 

 Fixed bug in Export to a .XLS or .XLSX file where the routine didn’t always write to a file stored under an active 

OneDrive folder. 

Version 4.01.08.04 – released on 23rd January 2026 

 Fixed bug where Projection Depth didn’t automatically update to end of projection when the Include Target 

Projection checkbox was checked. 

 

 Changed the default “KellyDown Documents” folder to C:\Users\[User]\KellyDown Documents to resolve issues 

associated with installing a database under the OneDrive folder. A shortcut to the KellyDown Documents folder is 

installed on the user’s Desktop. 

 
 

1available with licenses 2014.07 or later 
2available with Magnetic Ranging licenses 
3available with licenses 2015.06 or later 
4available with licenses 2016.03 or later 
5available with licenses 2017.06 or later 
6available with licenses 2018.06 or later 
7available only with licenses issued by Agilis 

8available with licenses 2020.04 or later 
9available with ROC Edition licenses 
10available with licenses 2021.08 or later 
11available with licenses 2022.08 or later 
12available with licenses 2023.06 or later 
13available with licenses 2024.06 or later 
14available with licenses 2025.06 or later

 


